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O DODATNIH APLIKACIJAH ZA NAPRAVO NOKIA N80
V pomnilniku naprave in na prilozenem CD-ju boste nasli dodatne aplikacije
druzbe Nokia in drugih izdelovalcev.

BREZ JAMSTEV

Aplikacije, ki ste jih dobili z napravo, so morda ustvarile in so morda v lasti fizi¢nih
ali pravnih oseb, ki niso odvisne oz. povezane z druzbo Nokia. Nokia nima avtorskih
pravic ali pravic intelektualne lastnine za te aplikacije drugih proizvajalcev, zato
ne prevzema odgovornosti za morebitno podporo konénim uporabnikom,
delovanje teh aplikacij ali informacije v aplikacijah ali tem gradivu. Nokia ne daje
nobenih jamstev za te aplikacije. Z UPORABO APLIKACIJ POTRJUJETE, DA SO
APLIKACIJE PONUJENE TAKSNE, KAKRSNE SO, BREZ KAKRSNIH KOLI JAMSTEV,
IZRECNIH ALI VSEBOVANIH, IN KOLIKOR TO DOVOUUJE VELJAVNA ZAKONODAJA.
SPREJEMATE TUDI, DA NITI DRUZBA NOKIA NITI NJENE PODRUZNICE NE DAJEJO
NOBENIH IZRECNIH ALI VSEBOVANIH ZAGOTOVIL ALI JAMSTEV, VKUUCNO,
VENDAR NE OMEJENO NA JAMSTVA O LASTNISTVU, PRIMERNOSTI ZA PRODAJO
ALl PRIPRAVNOSTJO ZA DOLOCEN NAMEN, TER DA APLIKACIJE NE KRS1JO
NOBENIH PATENTOV, AVTORSKIH PRAVIC, BLAGOVNIH ZNAMK ALI DRUGIH
PRAVIC TRETJIH OSEB.

© 2006 Nokia. Vse pravice pridrzane.

Nokia, Nokia Connecting People, Nseries in N80 so blagovne znamke ali zas¢itene
blagovne znamke druzbe Nokia Corporation. Druga omenjena imena izdelkov in
podjetij utegnejo biti blagovne znamke ali trgovska imena njihovih lastnikov.

Nokia nenehno razvija svoje izdelke ter si pridrzuje pravico do sprememb in
izboljsav vseh izdelkov, opisanih v tem dokumentu, brez predhodne najave.

DRUZBA NOKIA ALI NJENI DAJALCI LICENCE POD NOBENIM POGOJEM NE
PREVZEMAJO ODGOVORNOSTI ZA KAKRSNO KOLI IZGUBO PODATKOV ALI
DOHODKA ALI KAKRSNO KOLI POSEBNO, NAKLJUCNO, POSLEDICNO ALI POSREDNO
SKODO, KI BI NASTALA NA KAKRSEN KOLI NACIN, CE TO DOVOLJUJE VELJAVNA
ZAKONODAJA.

VSEBINA TEGA DOKUMENTA JE PONUJENA "TAKSNA, KOT JE". RAZEN ZA TO, KAR
ZAHTEVA ZAKON, NI ZA NATANCNOST, ZANESUIVOST ALI VSEBINO TEGA
DOKUMENTA NOBENIH JAMSTEV, NITI IZRECNIH NITI POSREDNIH, VKUUCNO Z
IZRECNIMI JAMSTVI ZA PRODAJO IN PRIPRAVNOSTJO ZA NEKI NAMEN, VENDAR NE
OMEJENO NANJE. DRUZBA NOKIA SI PRIDRZUJE PRAVICO DO SPREMEMBE TEGA
DOKUMENTA ALI NJEGOVEGA UMIKA KADAR KOLI IN BREZ PREDHODNEGA
OBVESTILA.

Nekateri izdelki ter aplikacije in storitve zanje ponekod niso na voljo. Podrobnosti
in informacije o jezikih, ki so na voljo, lahko dobite pri pooblas¢enih prodajalcih
izdelkov Nokia.

Nekateri postopki in funkcije so odvisni od kartice SIM in/ali omrezja, storitve za
vecpredstavnostna sporodila ali od zdruZljivosti naprav in podprtih oblik zapisov.
Nekatere storitve se placajo posebej.
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Uvod

Uvod

Oznaka modela: Nokia N80-1
V nadaljevanju Nokia N8O.

Nokia N80 je zmogljiva, pametna vecpredstavnostna
naprava. Nokia in drugi proizvajalci programske opreme
ponujajo vec aplikacij za e ve¢jo funkcionalnost vase
naprave Nokia N8O.

Nekatere od teh aplikacij so v pomnilniku naprave, druge
pa na CD-ju, ki ste ga prejeli z njo.

Ce Zelite uporabljati nekatere aplikacije, morate sprejeti
veljavne pogoje licenciranja.

Ikone v tem dokumentu prikazujejo, ali je aplikacija na
voljo v pomnilniku naprave ([m)) ali na CD-ju ((=)).
Druge pomembne informacije o napravi lahko preberete v
priroéniku za uporabo.

Preden lahko aplikacije uporabite, jih morate s CD-ja
namestiti v zdruzljiv osebni racunalnik.

Zaradi zasCite avtorskih pravic morda ne boste mogli
kopirati, spreminjati, prenasati ali posredovati nekaterih
slik, glasbe (vkljuéno s toni zvonjenja) in druge vsebine.

V napravi so lahko ob nakupu shranjeni zaznamki in
povezave za strani tretjih oseb. Z napravo lahko dostopate

tudi do drugih takih strani. Te strani niso nikakor povezane
z druzbo Nokia, ki ne jam¢i za njihovo vsebino in jih ne
priporoca. Ko dostopate do njih, upostevajte ustrezne
varnostne ukrepe.

Omrezne storitve

Da bi telefon lahko uporabljali, morate imeti dostop do
storitev ponudnika mobilnih storitev. Za $tevilne funkcije
potrebujete posebne omrezne storitve, ki niso na voljo v
vseh omrezjih ali pa jih boste morali, ¢e jih boste hoteli
uporabljati, posebej naroditi pri ponudniku storitev.
Navodila in informacije o stro3kih lahko dobite pri svojem
ponudniku storitev. Nekatera omrezja imajo lahko
omejitve, ki vplivajo na uporabo omreznih storitev.
Nekatera omrezja na primer ne podpirajo vseh storitev ali
znakov nekaterih jezikov.

Va3 ponudnik storitev je morda zahteval izklop ali
onemogodil vklop nekaterih funkcij v vasi napravi. V tem
primeru take funkcije ne bodo prikazane v meniju naprave.
Naprava je bila morda tudi posebej nastavljena; to lahko
vklju€uje spremembe imen in vrstnega reda menijev ter
spremembe ikon. Ve¢ informacij lahko dobite pri
ponudniku storitev.



Podpora

Podporo uporabnikom aplikacij, ki jih dobavijo drugi
izdelovalci, ponujajo ti izdelovalci. Ce imate z neko
aplikacijo tezave, pois¢ite pomo¢ na ustreznem spletnem
mestu. Spletne povezave najdete za opisom vsake
aplikacije v tem priro€niku.
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‘% Internet

Internetna telefonija

Z uporabo storitve za internetno telefonijo (omrezna
storitev) lahko kli¢ete in sprejemate klice po internetu.

Ce zelite vzpostaviti ali sprejeti internetni klic, mora biti
naprava povezana s storitvijo za internetno telefonijo.

Pritisnite & in izberite Internet > Internet. tel..

Da bi se lahko povezali s storitvijo internetne telefonije,
mora biti naprava v dosegu ustreznega omrezja, na primer
dostopne toc¢ke WLAN.

G Pomembno: Vedno omogodite enega od
razpolozljivih naCinov Sifriranja, da bi povecali varnost
povezave WLAN. Ce boste uporabili 3ifriranje, boste
zmanj3ali nevarnost nepooblasfenega dostopa do svojih
podatkov.

V nekaterih drzavah, na primer v Franciji, je uporaba
omreZja WLAN omejena. Vec informacij o tem lahko
dobite pri lokalnih pristojnih sluzbah.

Pri razli¢nih ponudnikih storitev so na voljo razli¢ne
dostopne tocke.

S storitvijo internetne telefonije se poveZete tako, da na
seznamu izberete eno od omrezZij za povezavo, ki so na
voljo, in pritisnete Izberi. Na zacetku seznama so prikazana
shranjena omreZja, ki jih oznaCuje . Vzpostavljanje
povezave koncate tako, da izberete Preklici.

Ko ste se uspesno povezali s storitvijo, lahko uporabljeno
omrezje WLAN shranite kot znano dostopno tocko.

Izberite Moznosti in med naslednjim:

Povezi se s storitvijo - Povezite se s storitvijo, e sta na
voljo storitev internetne telefonije in ustrezno omrezje za
povezavo.

Prekini pov. s storitvijo - Kon¢ajte povezavo s storitvijo
internetne telefonije.

Zamenjaj storitev - Izberite storitev internetne telefonije
za odhodne klice, Ce je naprava povezana z ve¢ storitvami.
Ta moznost je prikazana samo, ¢e je na voljo ve¢
nastavljenih storitev.

Konfiguriraj storitev - Nastavite nove storitve. Ta
moznost je prikazana samo, ¢e so na voljo nenastavljene
storitve.



Shrani omrezje - Shranite omreZje, s katerim ste trenutno
povezani. Ze shranjena omreZja na seznamu omrezij za
povezavo oznacuje Y. Ta moznost je prikazana samo, ¢e
ste povezani z omrezjem WLAN, ki ga 3e niste shranili.

Uporabi skrito omrezje - PoveZite se s storitvijo
internetne telefonije z uporabo skritega omrezja WLAN.

Osvezi - Ro€no osvezite seznam omreZij za povezavo. To
moznost uporabite, ¢e vasega omrezja WLAN ni na
seznamu. Seznam se tudi samodejno osvezi vsakih 15
sekund.

Nastavitve - Spremenite nastavitve.
Izhod - Zaprite aplikacijo.
Morda ne bodo vedno na voljo iste moznosti.

Naprava je lahko povezana samo z eno dostopno tocko
WLAN naenkrat. Z ve¢ storitvami internetne telefonije je
lahko povezana, Ce uporabite dve ali vec storitev z isto
dostopno tocko. Storitev, ki jo uporabljate za odhodne
internetne klice, vidite v prikazu omrezij za povezavo,
zamenjate pa jo tako, da izberete Zamenjaj storitev.

Ko ste povezani s storitvijo internetne telefonije, je v
pripravljenosti prikazan znak €% .

V aktivni pripravljenosti je morda Ze bliznjica za Internet.
tel. ali pa jo dodajte sami. Z uporabo bliznjice se lahko

roéno prijavite v storitev, €e sta na voljo storitev internetne
telefonije in dostopna to¢ka. Ce ste 7e povezani s storitvijo

internetne telefonije, naprava vprasa, ali Zelite povezavo
prekiniti.

V pripravljenosti vzpostavite internetni klic tako, da
vnesete telefonsko Stevilko ali internetni naslov in
pritisnete \a . Med nacinoma vnasanja ¢rk in Stevilk
preklapljate tako, da pridrzite tipko #. Klic konc¢ate tako,
da pritisnete = .

Internetno lahko klicete tudi v aplikacijah Imenik in
Dnevnik. V aplikaciji Imenik poklicete tako, da pritisnete
& in izberete Imenik, se pomaknete na zeleno vizitko in
izberete Moznosti > Internetni klic. V aplikaciji Dnevnik
pokli¢ete tako, da pritisnete & in izberete Moje aplik. >
Dnevnik > Zadniji klici in Neodgov. klici, Prejeti klici ali
Klicane $tev., se pomaknete na Zeleno vizitko in izberete
Moznosti > Pokli¢i > Internetni klic.

Ce je za prednostno vrsto klica nastavljen Internetni klic
in je naprava povezana s storitvijo internetne telefonije, se
privzeto uporablja internetno klicanje.

Vasa naprava podpira glasovne klice po internetu
(internetne klice). Klice v sili najprej poskusi vzpostaviti po
mobilnem omrezju. Ce ne uspe, poskusa klicati prek
ponudnika internetne telefonije. Ker je mobilna telefonija
bolj uveljavljena in zanesljiva, je priporo€ljivo klicanje v sili
po mobilnem omreZzju, kadar je to mogoce. Cestev dosequ
signala mobilnega omrezja, pred klicanjem preverite, ali je
vaSa mobilna naprava vklju€ena in pripravljena za klice v
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Internet

sili. MoZnost klicanja v sili z uporabo internetne telefonije
je odvisna od razpolozljivosti omrezja WLAN in podpore
ponudnika za klicanje v sili. 0 moZnosti klicanja v sili po
internetu se lahko pozanimate pri svojem ponudniku
internetne telefonije.

Nastavitve

Nastavitve storitev internetne telefonije si ogledate tako,
da pritisnete & in izberete Internet > Internet. tel. >
Nastavitve.

Ce zelite videti ali zamenjati prednostno vrsto odhodnih
klicev, izberite Moznosti > Spremeni > Prednostna vrsta
klica > Celi¢no ali Internetni klic.

Prikaz nastavitev za izbrano storitev odprete tako, da
izberete Moznosti > Odpri.

Morda ne bodo vedno na voljo iste moznosti.

Nastavitve storitve

Pritisnite & in izberite Internet > Internet. tel. >
Moznosti > Nastavitve > Nastavitve:.

Nastavitve storitve si ogledate tako, da izberete Vrsta
prijave in med naslednjim:

Samodejno - Omogocite samodejno prijavo v storitev
internetne telefonije. Naprava se bo samodejno povezala s
storitvijo, ko bo nasla znano omrezje.

Roéno - Roéno se prijavite v storitev internetne telefonije.

Ce uporabljate samodejno prijavo v omrezja WLAN,
naprava v rednih presledkih iS¢e omrezja WLAN, zato se
poveca poraba baterije in skrajSa njen ¢as delovanja.

Izberite Shranjena povez. omr., da bi videli omrezja za
povezavo, ki jih prepozna storitev internetne telefonije. Ta
omrezja se uporabljajo za samodejno prijavo, na seznamu
omrezij za povezavo pa jih oznacuje .

Izberite Uredi nast. storitve, da odprete posebne
nastavitve za izbrano storitev. Ta moznost je na voljo samo,
Ce imate v napravi nameScen programski vticnik za
storitev.

Shranjena omrezja za povezavo

Ce si zelite ogledati ali odstraniti omreja za povezavo, ki
ste jih shranili za storitev internetne telefonije, pritisnite
& in izberite Internet > Internet. tel. > Nastavitve >
Nastavitve: > Shranjena povez. omr..

Izberite Moznosti > Odstrani, da odstranite omrezje iz
storitve.



% Nalaganje! m
aw

V aplikaciji Nalaganje! lahko poiscete, si predogledate,
kupite, nalozite in nadgradite vsebino, storitve in
aplikacije, ki delujejo v vasi napravi Nokia N80. Tako zlahka
dostopate do iger, tonov zvonjenja, ozadij, aplikacij in
mnogih drugih vsebin. Predmeti so razvrS¢eni v kataloge in
mape razlicnih ponudnikov storitev. Pri razli¢nih
ponudnikih storitev so na voljo razliéne vsebine.

Pritisnite & in izberite Internet > Nalaganjel.

Aplikacija Nalaganje! za dostop do nazadnje
posodobljenih vsebin uporablja omrezne storitve.
Informacije o dodatnih predmetih, ki so na voljo z uporabo
aplikacije Nalaganje!, lahko dobite pri svojem ponudniku
storitev ali pa njihovem prodajalcu ali izdelovalcu.

Aplikacija Nalaganje! prejema trenutne posodobitve in
vam posreduje najnovejse vsebine, ki jih za vaSo napravo
ponuja ponudnik storitev. Ce Zelite roéno posodobiti
vsebine v aplikaciji Nalaganje!, izberite MoZnosti > Osvezi
seznam.

Ce elite skriti mapo ali katalog na seznamu, da bi na
primer videli samo predmete, ki jih pogosto uporabljate,
izberite Moznosti > Skrij. Vse skrite predmete znova
prikazete tako, da izberete Moznosti > Prikazi vse.

Ce Zelite kupiti izbrani predmet, izberite Moznosti > Kupi
v glavnem prikazu, mapi ali katalogu. Odpre se podmeni,
kjer lahko izberete razliCico predmeta in vidite informacije
o ceni. RazpoloZljive moznosti so odvisne od ponudnika
storitve.

Brezplacen predmet nalozZite tako, da izberete Moznosti >
Prenesi.

Nastavitve za Nalaganje!

Aplikacija bo napravo posodobila z najnovejSo vsebino, ki
jo omogocajo va$ ponudnik storitev in drugi razpoloZzljivi
kanali. Ce elite spremeniti nastavitve, izberite

Moznosti > Nastavitve in med naslednjimi moznostmi:

Dostopna tocka - Izberite dostopno tocko za povezavo s
streznikom ponudnika storitev in ali naj jo naprava vsakic¢
znova zahteva.

Samodejno odpiranje - Ce Zelite, da se nalozena
aplikacija ali vsebina samodejno odpre, izberite Da.

Potrditev predogleda - Ce Zelite, da se samodejno nalozi
predogled aplikacije ali vsebine, izberite Ne. Ce izberete
Da, vas bo naprava vedno vpra3ala, ali zelite naloziti
predogled.

Potrditev nakupa - Ce Zelite, da naprava zahteva
potrditev pred nakupom vsebine ali aplikacije, izberite Da.

Internet
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Ce izberete Ne, se bo postopek nakupa zacel takoj, ko
boste izbrali Kupi.

Ko doloCite nastavitve, izberite Nazaj.
Q Mobile Search @
SN

Z aplikacijo Mobile Search lahko hitro iS¢ete in
uporabljate lokalne storitve, spletna mesta, slike in
mobilne vsebine. PoiS¢ete lahko na primer restavracije in
trgovine v blizini ter jih poklicete, napredna tehnologija
izdelovanja zemljevidov pa vas usmeri do njih.

Uporaba aplikacije Mobile Search
Pritisnite & in izberite Internet > Iskanje.

Ko odprete aplikacijo Mobile Search, se prikaze seznam
kategorij. Izberite eno (na primer slike) in vnesite besedilo
v iskalno polje. Izberite Iskanje. Na zaslonu se prikazejo
rezultati iskanja.

Dodatne informacije

Ce pri uporabi aplikacije potrebujete dodatno pomo¢ in
navodila, izberite MozZnosti > Pomoc.

Ce zelite ve¢ informacij o aplikaciji, obis¢ite tudi spletno
stran www.mobilesearch.nokia.com/.



Povezovanje

EE Brezzicna tipkovnica
Nokia m

Ce elite napravo povezati z brezzi¢no tipkovnico Nokia
Wireless Keyboard ali drugo zdruzljivo brezzi¢no
tipkovnico, ki podpira profil vmesnika Bluetooth HID
(Human Interface Devices), uporabite aplikacijo Brezzi¢na
tipk.. Tipkovnica s celotno postavitvijo tipk QWERTY
omogoca udobno vnasanje besedila v sporo€ila, e-posto in
koledar. Tipkovnice so v prodaji posebe;.

1 Vklop vmesnika Bluetooth v napravi.

2 Vklopite tipkovnico.

3 Pritisnite tipko & in izberite moznost Povezov. >
Brezzic. tipk..

4 Da bi zaceli iskanje naprav z vmesnikom Bluetooth,
izberite Moznosti > Pois¢i tipkovnico.

5 Na seznamu izberite tipkovnico in pritisnite (o), da
vzpostavite povezavo.

6 Svojo napravo in tipkovnico seznanite tako, da v
napravo vnesete kodo po izbiri (od 1 do 9 3tevilk), nato
pa isto kodo vnesete Se s tipkovnico.

Preden boste lahko vnesli Stevke, ki sestavljajo kodo,
boste morda morali najprej pritisniti tipko Fn.

7 Ce naprava zahteva, da dolodite razporeditev
tipkovnice, jo izberite s seznama.

8 Ko se prikaze ime tipkovnice, se njeno stanje spremeni
v Pov. s tipkovnico vzpostavljena, zeleni kazalnik na
tipkovnici pa pocasi utripa, kar pomeni, da je
tipkovnica pripravljena na uporabo.

Podrobnosti o delovanju in vzdrzevanju tipkovnice najdete
v priro¢niku za njeno uporabo.

Storitev Pritisni in
govori (m

Pritisni in govori (PG) (omrezna storitev) je takojsnje
prenasanje govora prek internetnega protokola in je na
voljo v omreZzjih GSM/GPRS. Pritisni in govori omogoca
neposredno glasovno komunikacijo; povezava se vzpostavi
ob pritisku tipke. Prek storitve Pritisni in govori se lahko
pogovarjate z eno osebo ali skupino.

Preden lahko zaénete uporabljati storitev Pritisni in govori,
morate dolo¢iti dostopno to¢ko in nastavitve za Pritisni in
govori. Te lahko prejmete v posebnem besedilnem
sporoilu ponudnika storitve Pritisni in govori. Ce jo va3

Povezovanje




Povezovanje

ponudnik storitve podpira, lahko za nastavitev uporabite
aplikacijo Nast. carov.. Glejte ‘Nast. ¢arov." na strani 21.

Pritisnite & in izberite Povezov. > Moznosti PG.

Pri komunikaciji v storitvi Pritisni in govori prvi uporabnik
govori, drugi pa ga poslusajo po vgrajenem zvocniku.
Govorci se izmenjujejo. Ker lahko govori samo po en
uporabnik, je trajanje posameznega govora omejeno, po
navadi na 30 sekund. Informacije o trajanju govora v
domacem omrezju lahko dobite pri ponudniku storitev.

& Opozorilo: Med uporabo zvo¢nika naprave ne drzite
ob usesu, saj je lahko zelo glasna.

Telefonski klici imajo prednost pred pogovori s storitvijo
Pritisni in govori.

Dolocanje dostopne tocke za storitev
Pritisni in govori

Stevilni ponudniki storitev zahtevajo, da za privzeto
dostopno tocko uporabljate internetno dostopno tocko
(IAP). Drugi ponudniki storitev bodo dovolili tudi uporabo
dostopne tocke WAP. Vec informacij lahko dobite pri
ponudniku storitev.

Ce nimate vzpostavljene povezave WAP, se za pomo¢ pri
prvi povezavi obrnite na ponudnika storitev oziroma
obis¢ite spletno mesto www.nokia.com/phonesettings.

Nastavitve za storitev Pritisni in govori

Pritisnite tipko & in izberite moZnost Povezov. > Pritis. in
govori > MozZnosti > Nastavitve PG.

Izberite moZnost Uporabniske nastavitve in vpiSite
naslednje informacije:

Dohodni klici PG — Izberite moznost Obvescaj, e zelite
prejemati obvestila o dohodnih klicih. Izberite moZnost
Samodejno sprejmi, da telefon samodejno sprejema klice
PG. Izberite moznost Ni dovoljeno, e Zelite, da telefon
samodejno zavrne klice PG.

Opozorilni ton PG - Izberite Doloéeno s profilom, ¢e
Zelite, da se nastavitev opozarjanja na dohodne klice PG
spreminja skladno z nastavitvijo za dohodne glasovne klice
v vklju¢enem profilu.

Ton zaht. za povr. klice — Izberite ton za zahteve po
povratnem klicu.

Zagon aplikacije — Izberite, ali se Zelite prijaviti v storitev
Pritisni in govori, ko vklju¢ite napravo.
Privzeti vzdevek — VpiSite privzeti vzdevek, ki je prikazan

drugim uporabnikom. Ponudnik storitev je urejanje te
moznosti naprave mogoce izklju€il.

PrikaZi moj naslov PG — Izberite moznost Pri individual.
klicih, Pri skupinskih klicih, Pri vseh klicih ali Nikoli.



Ponudnik storitev je nekatere od teh moZznosti naprave
mogoce izklju€il.

Prik. moje stan. prijave — Izberite Da, Ce Zelite prikazati
svoje stanje, ali Ne, ¢e ga Zelite skriti.

Izberite moznost Nastavitve povezave in vpisite naslednje
informacije:

Domena — VpiSite ime domene, ki ste ga dobili od
ponudnika storitev.

Ime dostopne tocke — Vpisite ime dostopne tocke za
storitev Pritisni in govori. Ime dostopne tocke potrebujete
za vzpostavitev povezave z omrezjem GSM/GPRS.

Naslov streznika — Vpisite naslov IP ali ime domene za
streznik za storitev Pritisni in govori, ki ga dobite od
ponudnika storitev.

Uporabnisko ime — VpiSite uporabnisko ime, ki ga dobite
od ponudnika storitev.

Geslo — VpiSite geslo, ¢e ga potrebujete, da bi vzpostavili
podatkovno povezavo. Geslo ponavadi dobite od
ponudnika storitev in pogosto razlikuje med velikimi in
malimi ¢rkami.

Prijava v storitev Pritisni in govori

Pritisnite tipko & in izberite moZnost Povezov. > Pritis.
in govori. Aplikacija Pritisni in govori se ob zagonu
samodejno prijavi.

Ce je prijava uspe$na, se aplikacija Pritisni in govori
samodejno poveze s kanali, ki so bili aktivni, ko ste zadnji¢
zaprli aplikacijo. Ce je povezava prekinjena, se naprava
samodejno ponovno poskusa prijaviti, dokler ne zaprete
aplikacije.

Zapiranje aplikacije Pritisni in govori

Pritisnite tipko & in izberite moznost Povezov. > Pritis.
in govori > Moznosti > Izhod. Izpise se sporo€ilo Ali
zelite, da se po izhodu izaplikacije storitev Pritisni in
govori izkljuci?. Pritisnite tipko Da, da se odjavite in
zaprete aplikacijo. Pritisnite tipko Ne, da aplikacija ostane
vklju¢ena v ozadju. Ce je odprtih ve¢ aplikacij in Zelite
preklapljati med njimi, pridrzite tipko 4.

Pogovor z enim sogovornikom
Izberite Moznosti > Imenik Prit. in govori.

S seznama izberite sogovornika, s katerim se Zelite
pogovarjati, in nato Moznosti > Vzpost. individualni klic.

Med pogovorom ves ¢as drzite tipko A\ . Po koncanem
klicu sprostite tipko \a .

Povezovanje
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Govorite lahko tudi, ¢e pridrzite tipko = v drugih
prikazih aplikacije Pritis. in govori, na primer v imeniku.
Ce Zelite vzpostaviti nov klic, najprej konéajte klic z enim
sogovornikom. Izberite Prekini ali pritisnite (C .

féli Nasvet: Ko klicete z aplikacijo Pritisni in govori,
telefon drzite pred sabo, da lahko vidite zaslon.
Govorite v mikrofon in zvo¢nika ne zakrivajte z roko.

Prejemanje klica z enim sogovornikom

Pritisnite tipko \a , da bi zaceli pogovor z enim
sogovornikom, ali tipko = , da bi pogovor zavrnili.

:\é/: Nasvet: Vimeniku lahko vzpostavite skupinski klic ali
klic z enim sogovornikom tudi tako, da izberete
Moznosti > Moznosti PG > Pokli¢i posameznika ali
Pokliéi skupino.

Vzpostavitev skupinskih klicev

Ce zelite poklicati skupino, izberite Moznosti > Imenik
Prit. in govori, oznacite Zelene vizitke in izberite
Moznosti > Vzpost. skupin. klic PG.

Narocilo stanja prijave drugih
uporabnikov

Ce zelite naro¢iti ali preklicati narocilo na stanje
pripravljenosti drugih, izberite MoZnosti > Imenik Prit. in

govori, izberite sogovornika in nato Moznosti > Prikazi
stanje prijave ali Skrij stanje prijave.

Posiljanje zahteve po povratnem klicu

V meniju Imenik Prit. in govori pois€ite Zeleno ime in
izberite Moznosti > Poslji zaht. za povr. klic.

Odgovor na zahtevo po povratnem klicu

Ce vam drug uporabnik poslje zahtevo po povratnem klicu,
se v pripravljenosti izpiSe sporocilo 1 nova zahteva po
povratnem klicu. Pritisnite tipko Prikazi, da odprete
moznost Prejete zahteve. Izberite sogovornika in nato
Moznosti > Vzpost. individualni klic, da bi zaceli klic z
enim sogovornikom.

Kanali

Vkljuéite se lahko v predhodno nastavljene javne kanale.
Javni kanali so na voljo vsem uporabnikom, ki poznajo
naslov URL kanala.

Ko vzpostavite povezavo s kanalom in zaénete pogovor, vas
slisijo vsi €lani, ki so vklju€eni v kanal. Hkrati je lahko
vklju¢enih do pet kanalov. Ce je vklju¢enih ve¢ kanalov, s
pomo¢jo moznosti Preklopi izberite kanal, po katerem
Zelite govoriti.

Izberite MozZnosti > Kanali Pritisni in govori.



Ce se zelite prvi¢ povezati s predhodno nastavljenim
javnim kanalom, izberite Moznosti > Nov kanal > Dodaj
obstojecega. Da bi se vkljucili v predhodno nastavljeni
kanal, vnesite njegov naslov URL.

Ustvarjanje lastnih kanalov

Ce selite ustvariti lasten kanal, izberite Moznosti > Nov
kanal > Ustvari novega.

Ustvarjate lahko lastne javne kanale, izberete ime kanala in
vabite ¢lane. Ti €lani v javni kanal lahko povabijo 3e druge
Clane.

Nastavite lahko tudi zasebne kanale. V javne kanale se
lahko vklju€ujejo samo uporabniki, ki jih povabi gostitel].

Za vsak kanal dolocite naslednje lastnosti: Ime kanala,
Zasebnost kanala, Vzdevek v kanalu in Sli¢ica kanala
(neobvezno).

Ko ste uspesno ustvarili kanal, vas naprava vprasa, ali zelite
uporabnikom posiljati vabila. Vabila za vklju¢evanje v
kanale so besedilna sporo¢ila.

Pogovor prek kanala

Ce Zelite govoriti prek kanala, ko se prijavite v storitev
Pritisni in govori, pritisnite tipko \a . ZasliSite ton, ki
oznacuje, da imate omogocen dostop.

Med govorom ves ¢as drzite tipko A\ . Ko koncate,
sprostite tipko \a .

Ce se v kanal s pritiskom na tipko A= posku3ate vkIjuéiti,
ko govori drug uporabnik, se prikaze sporocilo Pocakajte.
Sprostite tipko \a , pocakajte, da uporabnik neha
govoriti, in ponovno pritisnite tipko A\ . Lahko pa tudi
drzite tipko \a in pocakate, da se izpiSe sporocilo
Govorite.

Ce govorite v kanalu, bo naslednja govorila oseba, ki prva
pritisne tipko \a , ko uporabnik neha govoriti.

Ko koncate klic prek storitve Pritisni in govori, izberite
moznost Prekini ali pritisnite tipko (C .

Ce si zelite ogledati trenutno aktivne ¢lane kanala,
medtem ko imate vzpostavljen klic s kanalom, izberite
Moznosti > Aktivni ¢lani.

Ce ste povezani s kanalom in Zelite vanj povabiti nove
¢lane, izberite Moznosti > Poslji vabilo, da se odpre prikaz
vabil. Nove ¢lane lahko povabite samo, e ste gostitelj
zasebnega kanala ali ¢e je kanal javen. Vabila za
pridruzitev kanalu so besedilna sporoéila.

Odgovor na vabilo za vkljuditev v kanal

Ce Zelite shraniti prejeto vabilo za vkljuéitev v kanal,
izberite Moznosti > Shrani kanal PG. Kanal je dodan v
imenik za PG, v prikaz kanalov.

Ko shranite vabilo za vkljuéitev v kanal, vas naprava
vprasa, ali se Zelite povezati s kanalom. Izberite Da, da bi
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odprli prikaz sej za storitev Pritisni in govori. Ce 3e niste
prijavljeni, se naprava prijavi v storitev.

Ce vabilo zavrnete ali zbridete, se shrani v mapo Prejeto v
meniju Sporoéila. Ce se Zelite pozneje kanalu pridruziti,
odprite vabilo in ga shranite. Povezavo s kanalom potrdite
z moznostjo Da.

Ogled dnevnika PG

Pritisnite £ in izberite Povezov. > Moznosti PG >
Moznosti > Dnevnik PG > Neodgov. klici, Sprejeti klici
PG in Zaceti klici.

Klic z enim sogovornikom lahko vzpostavite v meniju
Dnevnik PG, tako da pritisnete tipko \a .



Pisarna

Quickoffice m

Ce zelite uporabljati aplikacije Quickoffice, pritisnite & in
izberite Pisarna > Quickoffice. Odpre se seznam datotek v
zapisih .doc, .xls in .ppt, ki so shranjene v mapi
C:\Data\Documents v pomnilniku naprave ali v mapi
E:\Documents in njenih podmapah na pomnilniski kartici.

Datoteko odprete v ustrezni aplikaciji tako, da pritisnete
(@). Ce Zelite datoteke razvrstiti, izberite Moznosti >
Razvrsti datoteke.

Aplikacijo Quickword, Quicksheet ali Quickpoint odprete
tako, da preklopite med prikazi s pritiskom na (9.

Quickword

Z aplikacijo Quickword lahko na zaslonu naprave berete
izvirne Microsoft Wordove dokumente. Quickword podpira
barve ter krepke, poSevne in podértane pisave.

Quickword podpira pregledovanje dokumentov, shranjenih
v zapisu .doc in ustvarjenih v programu Microsoft Word 97
ali novejsem. Ne podpira vseh razli¢ic ali funkcij
omenjenega zapisa datotek.

Glejte tudi ‘Dodatne informacije' na strani 18.
Pregledovanje Wordovih dokumentov
Po dokumentu se premikajte s tipko za pomikanje.

Ce zelite v dokumentu iskati besedilo, izberite Moznosti >
Iskanje.

Izberete lahko tudi Moznosti in eno od naslednjih
moznosti:

Pojdi na - Pomaknite se na zacetek, izbrano mesto v
besedilu ali konec dokumenta.

Povecava - Povecajte ali pomanjsajte prikaz.

Zacni samopomikanje - Vkljudite samodejno pomikanje
po dokumentu. Prekinete ga tako, da pritisnete (o).

Quicksheet

Z aplikacijo Quicksheet lahko na zaslonu naprave berete
izvirne Microsoft Excelove dokumente.

Quicksheet podpira preglednice v zapisu .xls, shranjene v
programu Microsoft Excel 97 ali novejSem. Ne podpira
vseh razli¢ic ali funkcij omenjenega zapisa datotek.

Glejte tudi ‘Dodatne informacije' na strani 18.

Pisarna
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Pregledovanje preglednic
Po preglednici se premikajte s tipko za pomikanje.

Med delovnimi listi preklapljate tako, da izberete
Moznosti > Panoramsko.

Ce zelite v preglednici iskati besedilo znotraj vrednosti ali
formule, izberite MozZnosti > Iskanje.

Ce zelite zamenjati prikaz preglednice, izberite Moznosti
in eno od naslednjih moZnosti:

Pomikanje - Pomikajte se po trenutnem delovnem listu
po blokih. Blok vsebuje stolpce in vrstice, prikazane na
zaslonu. Ce Zelite prikazati stolpce in vrstice, s tipko za
pomikanje izberite blok in OK.

Povecava - Povecajte ali pomanjsajte prikaz.

Zamrzni podokna - Ce Zelite, da sta oznadena vrstica in
stolpec vidna med premikanjem po preglednici.

Spremeni velikost - Prilagodite velikost stolpcev ali
vrstic.

Quickpoint
Z aplikacijo Quickpoint lahko na zaslonu naprave berete
izvirne Microsoft PowerPointove predstavitve.

Quickpoint podpira pregledovanje predstavitev v
zapisu .ppt, ustvarjenih v programu Microsoft PowerPoint

2000 ali novejSem. Ne podpira vseh razlicic ali funkcij
omenjenega zapisa datotek.

Glejte tudi ‘Dodatne informacije’ na strani 18.

Pregledovanje predstavitev

Med prikazi strani, orisa in opomb se premikajte s
pritiskom na @) ali (9.

Na naslednjo ali prejSnjo stran predstavitve se premaknite
s pritiskom na () ali (®).

Ce selite predstavitev videti v celozaslonskem nacinu,
izberite Moznosti > Celozaslonsko.

Ce zelite razsiriti elemente v prikazu orisa, izberite
Moznosti > Razsiri vnos.

Dodatne informacije

Ce imate z aplikacijo Quickword, Quicksheet ali
Quickpoint tezave, obis¢ite spletno stran
www.quickoffice.com, kjer boste dobili ve¢ informacij.
Lahko tudi posljete e-poSto na naslov
supportS60@quickoffice.com.



Adobe Reader
Y |

Z Adobe Readerjem lahko na zaslonu naprave berete
dokumente .pdf.

Ta aplikacija je optimizirana za pregledovanje dokumentov
.pdf z mobilnimi telefoni in drugimi mobilnimi napravami
ter v primerjavi z racunalniskimi razli¢icami omogo¢a samo
omejeno zbirko funkcij.

Dostopanje do dokumentov in odpiranje:

e Pritisnite & in izberite Pisarna > Adobe PDF. Ce
zelite brskati med dokumenti, shranjenimi v pomnilniku
naprave in na zdruzljivi pomnilniski kartici, ter jih
odpreti, izberite Moznosti > Iskanje datoteke.

e Qdprite prilogo v prejetem e-po3tnem sporocilu
(omrezZna storitev).

® Po povezavi Bluetooth posljite dokument v mapo
Prejeto v meniju Sporocila.

® 7 aplikacijo Nadz. dat. brskajte med dokumenti,
shranjenimi v pomnilniku naprave in na pomnilniski
kartici, ter jih odpirajte.

® Brskajte po spletnih straneh. Pred brskanjem preverite,
ali je v napravi nastavljena internetna dostopna tocka.
Vec informacij o dostopnih tockah poiscite v priro€niku
za uporabo naprave.

Delo z datotekami .pdf

Ce Zelite poiskati datoteke .pdf in jih uporabiti, pritisnite
& inizberite Pisarna > Adobe PDF.V prikazu datotek so
tiste, ki ste jih nazadnje odprli. Ce Zelite odpreti dokument,
ga pois€ite in pritisnite (o).

Izberete lahko tudi Moznosti in eno od naslednjih
moznosti:

Iskanje datoteke - Ce Zelite iskati datoteke .pdf v
pomnilniku naprave ali na zdruzljivi pomnilniski kartici.

Nastavitve - Ce Zelite zamenjati privzeto stopnjo
povecave in nacin prikaza dokumentov .pdf.

Pregledovanje datotek .pdf

Ko je datoteka .pdf odprta, izberite Moznosti in med
naslednjim:

Povecava - Povecajte ali pomanjsajte prikaz ali ga
nastavite na dolocen odstotek. Povecavo lahko spremenite
tako, da bo stran ustrezala Sirini zaslona ali da bo na njem
prikazana celotna stran.

15¢i - Ce zelite v dokumentu iskati besedilo.

Prikaz - Dokument prikazite v celozaslonskem nacinu.
Dokument .pdf lahko tudi zasucete za 90 stopinj v obe
smeri.

Pisarna
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Pojdi na - Pomaknite se na izbrano, naslednjo, prejSnjo,
prvo ali zadnjo stran.

Shrani - Shranite datoteko v pomnilnik naprave ali na
zdruzljivo pomnilnisko kartico.

Nastavitve - Spremenite privzeto stopnjo povecave in
privzeti nadin prikaza.

Podrobnosti - Oglejte si lastnosti dokumenta .pdf.

Dodatne informacije

Ve¢ informacij lahko dobite na spletnem mestu
www.adobe.com.

Ce bi radi z drugimi uporabniki izmenjali vprasanja,
predloge in informacije o aplikaciji, obis¢ite forum
Adobe Reader for Symbian OS na spletni strani
http://adobe.com/support/forums/main.html.




Orodja

¢ Nast. carov. ®

Wi

Nast. ¢arov. na podlagi nastavitvenih informacij
ponudnika mobilnih storitev konfigurira vaSo napravo za
uporabo storitev MMS, GPRS in interneta, e-poste, storitve

Pritisni in govori (omrezna storitev) in souporabe videa
(omrezna storitev).

Da bi te storitve lahko uporabljali, vam bo ponudnik
storitev morda moral vkljuéiti podatkovno povezavo ali
druge storitve.

Pritisnite & in izberite Orodja > Nast. carov..

V meniju izberite storitev, za katero Zelite konfigurirati
napravo, in pritisnite (e).

E-posta

1 Ko dolocate e-postne nastavitve, Nast. carov. najde
razpolozljivega ponudnika storitev in zahteva, da ga
potrdite. Izberite V redu ali poiS¢ite drugega ponudnika
in izberite V redu.

2 S seznama izberite svojega ponudnika e-postnih
storitev.

5
6

7

Izberite streznik za posiljanje poste. Ce niste
prepricani, uporabite privzetega.

Nast. carov. zahteva, da vnesete e-postni naslov,
uporabnisko ime in geslo. Izberite posamezne
nastavitve in MozZnosti > Spremeni. Vnesite
podrobnosti in izberite V redu.

Ko koncate, izberite Moznosti > V redu.
Nastavitve nabiralnika pri dolo¢enem operaterju
(ponudniku storitev) potrdite tako, da izberete OK.
Izberite V redu.

Pritisni in govori

1

Ko Zelite nastaviti storitev Prit. in govori (omrezna
storitev), Nast. ¢arov. najde ponudnika storitev, ki vam
je na voljo, in zahteva, da ga potrdite. Izberite V redu
ali pois¢ite drugega ponudnika in izberite V redu.
Nekateri operaterji zahtevajo uporabnisko ime, geslo in
vzdevek. Izberite posamezne nastavitve in MozZnosti >
Spremeni. Vnesite podrobnosti in izberite V redu.

Ko koncate, izberite Moznosti > V redu.

Izberite V redu in tako potrdite, da Zelite nastaviti
storitev Prit. in govori za izbranega operaterja.
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Souporaba videa

1

Ko Zelite nastaviti omrezno storitev souporabe video
posnetkov (Skup. raba videa), Nast. ¢arov. najde
ponudnika storitev, ki vam je na voljo, in zahteva, da
ga potrdite. Izberite V redu ali poiS¢ite drugega
ponudnika in izberite V redu.

Nekateri operaterji zahtevajo naslov za souporabo
video posnetkov, uporabnisko ime in geslo. Izberite
posamezne nastavitve in Moznosti > Spremeni.
Vnesite podrobnosti in izberite V redu.

Ko koncate, izberite Moznosti > V redu.

Nastavitve souporabe pri doloéenem operaterju
(ponudniku mobilnih storitev) potrdite tako, da
izberete V redu.

Ko ustvarite nastavitve souporabe video posnetkov,
Nast. ¢arov. vprasa, e Zelite ustvariti ali posodobiti
lastno vizitko. Izberite Da ali Ne.

Operater

1

Ko Zelite doloditi operaterjeve nastavitve, Nast. ¢arov.

najde ponudnika storitev, ki vam je na voljo, in
zahteva, da ga potrdite. Izberite V redu ali pois¢ite
drugega ponudnika in izberite V redu.

Nastavitev naprave za dolocenega operaterja
(ponudnika mobilnih storitev) potrdite tako, da
izberete V redu.

Dodatne informacije

Ce imate z aplikacijo Nast. ¢arov. kakrsne koli tezave,
obis¢ite spletno stran Nokia za nastavitve telefona na
naslovu

www.nokia.com/phonesettings.

@/ Carovnik za WLAN @m

Carovnik za WLAN vam pomaga vzpostavljati in upravljati
povezave z omrezji WLAN.

Carovnik za WLAN v aktivni pripravljenosti prikazuje stanje
povezav z omrezji WLAN. RazpoloZzljive moznosti si
ogledate tako, da se pomaknete v vrstico s stanjem in
pritisnete @.

Ce so prikazane informacije o najdenih omrezjih WLAN, na
primer Najdeno omrezje WLAN, izberite stanje, moZnost
Zacni spletno brskanje in omrezje, da bi ustvarili
internetno dostopno tocko in zagnali spletni brskalnik.

Ce izberete zai¢iteno omrezje WLAN, morate vnesti
ustrezne kode za dostop. Ce se zelite povezati s skritim
omrezjem, morate vnesti pravilno ime omrezja (SSID).

Ko ste povezani z omrezjem WLAN, sta prikazani ime
internetne dostopne tocke in stanje Povez. z omreZz.". Ce
Zelite zagnati spletni brskalnik z uporabo te dostopne



tocke, izberite stanje in moznost Nadaljuj brskanje.
Povezavo z omrezjem WLAN koncate tako, da izberete
stanje in moznost Prekini povezavo WLAN.

Ce je iskanje omrezij WLAN izkljuéeno in niste povezani z
nobenim omrezjem, je prikazano obvestilo Iskanje WLAN-
ov izkljuéeno. Ce zelite vkljuéiti iskanje razpolozljivih
omrezij WLAN, izberite stanje Iskanje WLAN-ov
izkljuceno.

Iskanje omrezij WLAN zazenete tako, da izberete stanje in
moznost IS¢i omrezja WLAN. Iskanje izkljucite tako, da
izberete stanje in moznost Izkljuci iskanje WLAN-ov.

Carovnika za WLAN odprete v meniju tako, da pritisnete
& inizberete Internet > Orodja > Carovn. WLAN.
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$ racuna

Za va

Za vas racunalnik

Aplikacija Home Media Server @

G Pomembno: Da bi povecali varnost povezave WLAN,
naj bo vedno omogocen eden od nacinov Sifriranja, ki so
na voljo. S Sifriranjem boste zmanj3ali nevarnost
nepooblaséenega dostopa do svojih podatkov.

Aplikacija Home Media Server se s tehnologijo UPnP prek
brezziénega omrezja LAN povezuje z zdruzljivimi
napravami. Arhitektura UPnP uporablja varnostne
nastavitve brezziéne omreZne povezave.

Aplikacija Home Media Server omogoca samodejno
katalosko razvrs¢anje glasbe, slik in videoposnetkov na
zdruzljivem racunalniku. Ustvarjate lahko osebne
glasbene sezname predvajanja, albume s fotografijami in
filmske zbirke. ZdruzZljive predstavnostne datoteke lahko
prenadate v napravo, varnostne kopije datotek v napravi
pa lahko prenesete v racunalnik. Napravo lahko
uporabljate kot daljinski upravljalnik in predstavnostne
datoteke v napravi ali raunalniku prikazujete z omreznim
domacim predvajalnikom, ki podpira tehnologijo UPnP,
kot so racunalnik, televizor ali glasbeni sistem.

Namestitev aplikacije Home Media
Server v racunalnik

Aplikacijo Home Media Server v racunalnik namestite s
CD-ja, ki ste ga prejeli z napravo. Aplikacija Home Media
Server zahteva operacijski sistem Microsoft Windows 2000
ali Windows XP. Ce je va$ racunalnik zas¢iten s pozarnim
zidom, boste mogocée morali spremeniti njegove
nastavitve, da ga boste lahko povezali z napravo Nokia
N80. Ravnajte se po navodilih za namestitev, ki jih vidite
na zaslonu.

Delo s predstavnostnimi datotekami

Ce zelite slediti svojim skladbam, digitalnim fotografijam
in video posnetkom, datoteke najprej poiscite v zdruzljivem
raCunalniku, nato pa dodajte datoteke ali celotne mape v
domaci predstavnostni streznik.

Mape v racunalniku, v katerem boste imeli zdruzljive
predstavnostne datoteke, lahko oznadite kot opazovalne
mape. Ko dajete vanje nove predstavnostne datoteke, jih
programska oprema Home Media Server doda v vaso
knjiznico in jih posodablja.



Prenos datotek iz racunalnika v
mobilno napravo

1 Vzpostavite povezavo med napravo Nokia N80 in
aplikacijo Home Media Server v zdruzljivem
racunalniku.

V racunalniski aplikaciji Home Media Server v meniju
naprav izberite napravo Nokia N80.

2 Izberite knjiznico predstavnostnih datotek, ki jo zelite
prenesti.

3 Izberite eno predstavnostno datoteko.

4 |zberite moznost za prenos datoteke v napravo Nokia
N8o0.

Prenos datotek iz mobilne naprave v
racunalnik

1 Napravo Nokia N80 poveZite z domacim
predstavnostnim streznikom v zdruzljivem racunalniku
ali pa v racunalniku z uporabo aplikacije Home Media
Server izberite napravo Nokia N80 v meniju naprav.

2 |zberite datoteko, ki jo Zelite prenesti.

3 Izberite moznost za prenos datoteke v domadi
predstavnostni streznik v zdruzljivem racunalniku.

Ogled datotek, ki so v racunalniku, v
drugih napravah

Napravo Nokia N80 lahko uporabljate kot daljinski
upravljalnik za prikazovanje zdruzljivih predstavnostnih
datotek iz aplikacije Home Media Server v ra¢unalniku z
drugimi zdruzljivimi napravami v domacem omrezju, ki
podpirajo tehnologijo UPnP.Z napravo Nokia N80 lahko na
primer zdruzljive glasbene datoteke v racunalniku
predvajate z glasbenim stolpom z uporabo zdruzljivega
vecpredstavnostnega sprejemnika, ki podpira tehnologijo
UPnP.

Nadzor predstavnostnih datotek z mobilno
napravo Nokia

1 Vzpostavite povezavo med napravo Nokia N80 in
aplikacijo Home Media Server v zdruzljivem
racunalniku.

2 Izberite knjiznico predstavnostnih datotek, v kateri je
datoteka, ki jo Zelite nadzorovati.

3 Izberite predstavnostno datoteko.

4 |zberite zdruzljivo napravo, v kateri je datoteka
prikazana.
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Dodatne informacije

Ve¢ informacij o aplikaciji Home Media Server lahko
dobite na spletnem mestu www.simplecenter.net/nokia
ali tako, da s pritiskom na F1 v aplikaciji Home Media
Server odprete Pomo¢.

%‘ Nokia Lifeblogm &

Nokia Lifeblog je kombinacija programske opreme za
mobilni telefon in osebni raCunalnik, ki hrani
vecpredstavnostni dnevnik predmetov, ki jih zbirate z
napravo. Nokia Lifeblog samodejno razvrsti vase
fotografije, video posnetke, zvoke, besedilna in
vecpredstavnostna sporoCila ter objave v spletnem
dnevniku na ¢asovni seznam, po katerem lahko brskate,
iSCete, dajete predmete v souporabo, jih objavljate in
varnostno kopirate. Z aplikacijama Nokia Lifeblog za
racunalnik in Nokia Lifeblog za mobilni telefon lahko
posljete predmete ali jih objavite v spletnem dnevniku, da
jih bodo videli tudi drugi.

Nokia Lifeblog za mobilni telefon samodejno sledi vasim
vecpredstavnostnim predmetom. Z aplikacijo Nokia
Lifeblog lahko v svoji mobilni napravi brskate med
predmeti, jih posljete ali objavite v spletu. Napravo
povezite z zdruzljivim racunalnikom po podatkovnem

kablu USB ali povezavi Bluetooth in predmete v njej
prenesite v racunalnik ali pa jih z njim sinhronizirajte.

Nokia Lifeblog za rac¢unalnik omogoca preprosto brskanje
po predmetih in iskanje predmetov, zbranih v napravi. S
pritiskom ene tipke lahko svoje najljub3e fotografije, video
posnetke, besedila in ve¢predstavnostna sporocila
prenesete po podatkovnem kablu USB ali vmesniku
Bluetooth nazaj v svojo napravo.

Za vegjo varnost lahko naredite varnostno kopijo zbirke
podatkov Nokia Lifeblog na trdem disku, zdruzljivem CD-ju,
zdruzljivem DVD-ju, zdruZljivem izmenljivem disku ali
zdruzljivem omreznem pogonu. Poleg tega lahko predmete
objavite v zdruzljivem spletnem dnevniku (blogu).

Aplikacijo Lifeblog v svoji napravi zaZenete tako, da
pritisnete & in izberete Moje aplik. > Lifeblog >
Moznosti > Odpri.

Namestitev v racunalnik &

Preden namestite aplikacijo Nokia Lifeblog v zdruzljiv

raCunalnik, potrebujete:

® 1 GHz Intel Pentium ali zmogljive;jsi, 128 MB RAM

® 400 MB prostora na trdem disku (¢e morate namestiti
tudi Microsoft DirectX in programsko opremo Nokia PC
Suite)
Lo¢ljivost 1024 x 768 in 24-bitno barvno paleto
Grafi¢no kartico s 32 MB



e Microsoft Windows 2000 ali Windows XP

Ce zelite aplikacijo Nokia Lifeblog namestiti v ra¢unalnik:

1 Vstavite CD, ki ste ga dobili z napravo.
2 Namestite programski paket Nokia PC Suite (vkljucuje

gonilnike za povezovalni kabel Nokia za povezavo USB).

3 Namestite Nokia Lifeblog za osebni ra¢unalnik.

Ce program Microsoft DirectX 9.0 3¢ ni name3gen v vasem
racunalniku, se namesti skupaj z aplikacijo Nokia Lifeblog
za racunalnik.

Povezovanje mobilne naprave in
racunalnika

Ce elite povezati mobilno napravo in zdruzljiv racunalnik

z zdruZljivim podatkovnim kablom USB:

1 Poskrbite, da bo nameScen programski paket Nokia PC
Suite.

2 Podatkovni kabel USB povezZite z mobilno napravo in
racunalnikom. Ko mobilno napravo povezete z
racunalnikom prvi¢ po namestitvi programa Nokia PC
Suite, racunalnik namesti posebne gonilnike zanjo. To
lahko traja nekaj ¢asa.

3 ZazZenite aplikacijo Nokia Lifeblog za racunalnik.

Ce Zelite povezati mobilno napravo in zdruzljiv raéunalnik
z uporabo brezziéne tehnologije Bluetooth:

V racunalniku mora biti namesSéen programski paket

Nokia PC Suite.

Preverite, ali sta se naprava in racunalnik seznanila z

uporabo brezzi¢ne tehnologije Bluetooth in aplikacije

Vzpostavljanje povezave v programskem paketu Nokia

PC Suite. Glejte razdelek ‘Nokia PC Suite' na strani 29

in priro¢nik za uporabo naprave.

3 Vklopite vmesnik Bluetooth v napravi in racunalniku.
Podrobnosti poiscite v priro¢niku za napravo in v
dokumentaciji racunalnika.

N

Kopiranje predmetov

Ko je naprava povezana z zdruzljivim racunalnikom prek
kabla USB ali vmesnika Bluetooth, lahko kopirate
predmete iz naprave v racunalnik in obratno.

Ce zelite kopirati nove ali urejene predmete iz naprave v

racunalnik in izbrane predmete iz racunalnika v napravo:

1 VracCunalniku zazenite aplikacijo Nokia Lifeblog.

2V aplikaciji Nokia Lifeblog za rac¢unalnik izberite File >
Copy from phone and to Phone.

Novi predmeti se tako prekopirajo iz naprave v racunalnik.
Predmeti v prikazu To phone v racunalniku se prekopirajo
Vv napravo.
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Objave v spletu

Ce Zelite izmenjati predmete iz aplikacije Nokia Lifeblog,
jih posljite v spletni dnevnik, kjer jih lahko vidijo tudi
drugi.

Najprej morate pri ponudniku storitev spletnega dnevnika
odpreti racun, ustvariti enega ali ve¢ dnevnikov, v katerih
objavljate, in racun spletnega dnevnika dodati v aplikacijo
Nokia Lifeblog. Priporocena storitev spletnega dnevnika
za aplikacijo Nokia Lifeblog je TypePad podjetja Six Apart,
www.typepad.com.

V napravi v aplikaciji Nokia Lifeblog dodajte racun
spletnega dnevnika v nastavitve za spletni dnevnik.
V racunalniku uredite racun v oknu Edit log accounts.

Za objavljanje predmetov iz vaSe naprave v spletu:

1 V mapi Timeline ali Favourites izberite predmete, ki
jih Zelite objaviti v spletu.

2 Izberite Moznosti > Post to Web.

3 Ce to funkcijo uporabljate prvi¢, aplikacija Nokia
Lifeblog iz streZnika spletnih dnevnikov nalozi seznam
dnevnikov.

4 Qdpre se pogovorno okno za objavo v spletnem
dnevniku. S seznama Post to: izberite spletni dnevnik,
ki ga Zelite uporabljati. Ce ste ustvarili nove spletne
dnevnike, izberite Moznosti > Refresh weblog list, da
bi posodobili seznam spletnih dnevnikov.

5 Vnesite naslov in napis za objavo. V polje telesa
besedila lahko napisete tudi daljSe besedilo.

6 Ko ste vse pripravili, izberite Moznosti > Send.

Za objavljanje predmetov iz ra¢unalnika v spletu:

1 V mapi Timeline ali Favourites izberite predmete
(najve¢ 50), ki jih Zelite objaviti v spletu.

2 |zberite File > Post to the Web.... Odpre se okno Post
to the Web.

3 Vnesite naslov in napis za objavo. V polje telesa
besedila lahko napisete tudi daljSe besedilo.

4 S seznama Post to: izberite spletni dnevnik, ki ga Zelite
uporabljati.

5 Ko ste vse pripravili, kliknite gumb Send.

Uvazanje predmetov iz drugih virov

Poleg slik v zapisu .jpeg, ki ste jih posneli s svojo napravo,
lahko v aplikacijo Nokia Lifeblog uvozite tudi slike v
zapisu .jpeg, video posnetke .3gp in .mp4, zvocne
datoteke .amr in besedilne datoteke .txt iz drugih virov
(kot so CD, DVD ali mape na trdem disku).

Uvoz slik ali videoposnetkov iz ra¢unalnika v Nokia Lifeblog

za raCunalnik:

1 V mapi Timeline ali Favourites izberite File > Import
from PC.... Odpre se okno Import.

2 Na seznamu poiséite sliko, video posnetek, zvocno ali
besedilno datoteko ali pa se pomaknite do drugih map,
da bi poiskali datoteko, ki jo Zelite uvoziti. Za brskanje



po drugih pogonih ali napravah uporabite seznam Look
in.

3 Izberite mapo, datoteko ali ve¢ datotek. Vsebino si
lahko ogledate v podoknu Preview:.

4 Da bi uvozili mapo (vkljuéno s podmapami) ali izbrane
datoteke, kliknite moznost Import.

Brskanje po mapah Casovni trak in
Priljubljeno

Ko v ra¢unalniku zaZenete aplikacijo Nokia Lifeblog, se
lahko na ve¢ nacinov pomikate po prikazih Timeline in
Favourites. Najhitreje je, ¢e primete in drZite drsnikter ga
hitro ali pocasi premikate naprej ali nazaj. Lahko kliknete
tudi ¢asovno premico, da izberete datum, uporabite

funkcijo Go to date... ali pa uporabite pus¢i¢ne tipke.

Dodatne informacije

Ve¢ informacij o storitvah spletnih dnevnikov in njihovi
zdruzljivosti z aplikacijo Nokia Lifeblog lahko najdete na
spletnem mestu visit www.nokia.com/lifeblog ali tako, da
s pritiskom na F1 v aplikaciji Nokia Lifeblog v racunalniku
odprete pomoc¢ za Nokia Lifeblog.

Nokia PC Suite ®

Nokia PC Suite je programska oprema za racunalnik, ki je
namenjena uporabi z mobilno napravo Nokia N80.

Ce zelite namestiti in uporabljati programsko opremo
Nokia PC Suite, potrebujete racunalnik, ki ima names¢en
operacijski sistem Microsoft Windows 2000 ali XP in je
zdruzljiv s kablom USB ali opremljen z vmesnikom
Bluetooth. Preden programsko opremo Nokia PC Suite
uporabite, jo morate namestiti v racunalnik. Vec

informacij boste nasli na CD-ju, ki ste ga prejeli z napravo.

Celotni priroénik za uporabo programske opreme Nokia PC
Suite je na voljo v elektronski obliki na CD-ju. Ve¢
informacij in navodila za prenos najnovejse razlicice zbirke
Nokia PC Suite najdete na spletni strani www.nokia.com/
pcsuite.

Med uporabnimi aplikacijami v programskem paketu
Nokia PC Suite so:

Vzpostavljanje povezave - S to aplikacijo prvi¢ poveZete
svojo napravo z zdruzljivim raéunalnikom.

Synchronise - Z aplikacijo Nokia PC Sync sinhronizirajte
imenik, koledar, opravila in belezke med mobilno napravo
in zdruzljivim upraviteljem osebnih podatkov (PIM) v
zdruzljivem racunalniku.
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Backup - Z aplikacijo Content Copier varnostno
kopirajte podatke v napravi ali obnovite shranjene
podatke iz zdruZljivega racunalnika v napravo.

Store images - Z aplikacijo Image Store shranite slike in
video posnetke iz mobilne naprave v zdruzljiv racunalnik.

File manager - Z aplikacijo Nokia Phone Browser in
Windows Explorerjem (Raziskovalcem) upravljajte vsebino
map v mobilni napravi.

Transfer music - Z aplikacijo Nokia Music Manager
ustvarite in razvrstite datoteke z digitalno glasbo v
zdruzljivem racunalniku ter jih prenesite v zdruZzljive
naprave.

Connect to the Internet - Z aplikacijo One Touch Access
vzpostavite povezavo z omrezjem, pri ¢emer mobilno
napravo uporabite kot modem.

View multimedia - Z aplikacijo Nokia Multimedia
Player predvajajte video posnetke in slike ter pretvarjajte
zvocne in video datoteke.

Dodatne informacije

Ve¢ informacij in navodila za prenos najnovejse razlicice
programske opreme Nokia PC Suite lahko najdete na
spletnem mestu www.nokia.com/pcsuite.

Adobe Photoshop Album
— Starter Edition ©

Adobe Photoshop Album Starter Edition 3.0 vam z uporabo
zdruzljivega racunalnika pomaga iskati, popravljati in
posiljati fotografije. S to razlicico programske opreme
Starter Edition lahko:
® Uporabite oznake in organizirate fotografije tako, da jih
lahko hitro najdete.
® Uporabite koledarski prikaz, da bi videli vse svoje
digitalne fotografije na enem mestu.
Popravite pogoste napake na fotografijah.
Na razli¢ne nacine poSiljate fotografije: poSiljanje po e-
posti, tiskanje doma ali poSiljanje v zdruzljive mobilne
naprave.

Namestitev

Aplikacijo Adobe Photoshop Album Starter Edition
namestite v zdruZljiv racunalnik s CD-ja, ki ste ga prejeli z
napravo. Za program Starter Edition potrebujete
operacijski sistem Microsoft Windows 2000 ali XP,
programski paket Nokia PC Suite 6.5 ali novejSega za
povezovanje naprave in racunalnika ter program Apple
QuickTime 6.5.1. ali novejSega za pregledovanje in urejanje
video posnetkov.



Programska oprema Nokia PC Suite je na CD-ju, ki ste ga
prejeli z napravo. Ce v raéunalniku nimate nameséene
programske opreme Apple QuickTime, jo lahko namestite s
spletnega mesta www.apple.com/quicktime/download.
Ravnajte se po navodilih za namestitev, ki jih vidite na
zaslonu.

Prenos fotografij in videoposnetkov iz
naprave Nokia N80 v racunalnik

Fotografije lahko iz telefona v program Starter Edition
prenesete na dva nacina.

Za samodejen prenos fotografij in videoposnetkov v
zdruzljiv racunalnik:

1 Mobilno napravo povezite z zdruzljivim racunalnikom
po kablu USB. V racunalniku se odpre pogovorno okno
Adobe Photo Downloader, nove fotografije in video
posnetki, shranjeni po zadnjem prenosu, pa so
samodejno izbrani.

2 Da bi zaceli prenos, kliknite moznost Get Photos. Vse
izbrane datoteke se uvozijo v program Starter Edition.
Vsi albumi, ki ste jih ustvarili v aplikaciji Galerija, se
samodejno prenesejo v program Starter Edition in so
prepoznani po oznakah.

3 lzberete lahko moznost, da se datoteke po prenosu v
program Starter Edition iz naprave zbrisejo.

Ce zelite omogoditi ali onemogoditi pojavljanje
pogovornega okna Adobe Photo Downloader, z desno
miskino tipko kliknite ikono v opravilni vrstici.

Ro€no prenasanje fotografij v zdruzljiv raunalnik:

1 Napravo povezite z zdruzljivim ra¢unalnikom prek
kabla USB ali vmesnika Bluetooth.

2 Zazenite program Starter Edition.

3V vrstici z bliznjicami kliknite moznost Get photos >
From Camera, Mobile Phone ali Card Reader. Odpre
se pogovorno okno Adobe Photo Downloader.

4 Da bi zaceli prenos, kliknite moznost Get Photos. Vse
izbrane datoteke se uvozijo v program Starter Edition.
Vsi albumi, ki ste jih ustvarili v aplikaciji Galerija, se
samodejno prenesejo v program Starter Edition in so
prepoznani po oznakah.

5 Izberete lahko moznost, da se datoteke po prenosu v
program Starter Edition iz naprave zbrisejo.

Prenos fotografij in videoposnetkov iz
racunalnika v napravo Nokia N80

Za prenos urejenih fotografij in videoposnetkov nazaj v
telefon:

1 Napravo povezite z zdruzljivim racunalnikom prek
kabla USB ali vmesnika Bluetooth.
2 ZaZenite program Starter Edition.
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3 Izberite fotografije in videoposnetke, ki jih Zelite
prenesti v napravo.

4V vrstici z bliznjicami kliknite moznost Share in
izberite Send to Mobile Phone.

5 Kliknite OK.

Organiziranje in iskanje fotografij po
datumu

Starter Edition samodejno organizira vase fotografije po
datumih, tako da jih lazje najdete. Fotografije lahko po
datumih iSCete na dva nacina: v prikazu zbirke fotografij
(Photo Well) in prikazu koledarja (Calendar View).
Iskanje fotografij v zbirki slik:
1 V vrstici z bliznjicami izberite moznost Photo Well.
2 Na ¢asovnem traku pod vrstico z bliznjicami izberite
mesec, v katerem je bila posneta fotografija, ki jo Zelite
videti. Fotografije, posnete v tem mesecu, so prikazane
v zbirki fotografij.

Iskanje fotografij v prikazu koledarja:

1 Vrstici z bliznjicami izberite moznost Calendar View.

2 V prikazu koledarja izberite dan in si oglejte vse
fotografije, posnete na ta dan.

3 Pomikajte se med meseci s pus€icami na vrhu
koledarja.

Organiziranje in iskanje fotografij z
uporabo oznak

Pois¢ite fotografije s pomogjo kljuénih besed, ki so osebe,
kraji in druge znacilnosti fotografije. Ko fotografijo
oznacite, si ni treba zapomniti imena datoteke, datuma ali
mape za vsako fotografijo.

V vrstici z bliznjicami kliknite moZnost Organize, da
odprete podokno Tag.

Ustvarite lastne oznake:

1 V podoknu Tag kliknite New in izberite New Tag.

2 V pogovornem oknu Create Tag z uporabo menija
Category izberite, pod katero podkategorijo zelite
uvrstiti oznako.

3 V polje Ime vnesite ime, ki ga zelite dodeliti oznaki.

4 V polje Note vnesite informacije o oznaki, ki jih Zelite
dodati.

5 Kliknite OK.

Oznaka se prikaze v pogovornem oknu Tag, v izbrani
kategoriji ali podkategoriji.

Da bi fotografijam dodelili oznake, iz podokna Tag
povlecite oznako na fotografijo v zbirki fotografij.

Ce zelite najti fotografijo, dvakrat kliknite oznako v
podoknu Tag; iskalnik najde vse fotografije z izbrano
oznako.



Ce zelite zoziti izbor fotografij in se pomakniti na dolocen
mesec, kliknite vrstico na ¢asovnem traku.

Cev napravi ustvarite nov album, vanj dodate fotografije
in jih prenesete v aplikacijo Starter Edition, se informacije
o albumu prikaZejo kot nova oznaka pod moznostjo
Imported tags.

Popravljanje fotografij

Da bi odpravili najpogostejSe tezave s fotografijami:

1 Izberite fotografijo v zbirki.

2 Vvrstici z bliznjicami izberite moznost Fix photo.
Aplikacija Starter Edition naredi kopijo izvirne
fotografije, ki jo Zelite urejati.

Da bi samodejno popravili fotografijo, izberite moZnost
Auto Smart Fix.

Ce zelite fotografijo popravili roéno, izberite moznost
Fix Photo Window. in nato:

General — Izbere samodejno popravljanje barv, ravni,
kontrasta ali ostrine.

Crop — Fotografijo obreZe tako, da izboljSa kompozicijo
ali poudari podobo.

Red Eye — Odpravi u¢inek rdecih o¢i, ki ga povzrogi
bliskavica fotoaparata.

Predvajanje in urejanje videoposnetkov

Ce zelite predvajati videoposnetke, dvakrat kliknite na
videoposnetek in pod oknom za predvajanje kliknite Play.

Urejanje, prestavljanje in brisanje prizorov v

videoposnetkih, posnetih z mobilnim telefonom:

1 Zdesno miskino tipko kliknite datoteko s posnetkom in
izberite moznost Edit Mobile Movie. V oknu za
predvajanje vidite prvo slicico videoposnetka. Modra
oznaka na ¢asovnem traku pod oknom za predvajanje
oznacuje sli¢ico, ki jo gledate.

2 Za predvajanje, premor, prekinitev, skok na zacetek ali
konec uporabite tipke pod oknom za predvajanje. Da bi
se premikali po posnetku, povlecite oznako po
¢asovnem traku.

3 Da bi izbrali del videoposnetka, ki ga Zelite obrezati,
preurediti ali zbrisati, naredite naslednje:
® Povlecite drsnika za izbiro, ki sta na zacetku in

koncu ¢asovnega traku.
® Da bi oznadili zacetni ¢as izbire, pridrzite tipko Shift
in kliknite na ¢asovni trak. Da bi oznadili kon¢ni ¢as
izbire, pridrzite tipko Ctrl in kliknite na ¢asovni trak.
Ko ste izbrali del posnetka, lahko povlecete vrstico za
izbiro na €asovni trak.

4 Da bi zbrisali izbrani del posnetka, v orodni vrstici
kliknite Delete.

Izbrani del posnetka izrezete tako, da v orodni vrstici
kliknete Crop.
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e Da bi kopirali izbrani del posnetka, v orodni vrstici
£ kliknite Copy. Modro oznako povlecite na zeleno tocko
g na ¢asovnem traku in kliknite Paste.

S

's  Dodatne informacije

8 Ce zelite dodatno pomo¢ o funkeijah programa, v glavnem
> meniju izberite Help > Adobe Photoshop Album Help.
3]

N Ve¢ informacij o programski opremi Starter

Edition lahko najdete na spletnem mestu
www.adobe.com/products/photoshopalbum/starter.html.




